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Eurycea in Austin, TX
Teacher Page

Essential Questions: Topical Questions:

Objectives

Teacher Management

Estimated Time for Completion
2 class periods

Materials

Groundwater video “Austin Underground”
Computers

Salamander images file

Teacher Prep

This activity is designed to follow part 3 of the video “Austin Underground” and
instruction on statistics.

Reserve computer lab or provide computers for students (or groups)

Follow instructions for ImagedJ software download

Save salamander image files to computers

Safety Considerations
N/A

Vocabulary Building Strategies

Background Information for Teacher

MORPHOMETRICS BACKGROUND

Usually, the first information that is used to differentiate between two species or
populations is information on what the organisms look like. This includes qualitative
differences (such as color patterns), as well as quantitative differences (often some
aspect of shape). The methods that are used to describe and analyze shape are
collectively known as morphometric analyses. Here our attention will be on quantitative
differences.

Imaged is a free public source image processing and analysis program provided by the
National Institute of Health. While the program has extensive application in the
sciences, this introduction will cover only a few tools relevant to the lesson
“Morphometrics of Eurycea in Austin, TX".




STATISTICS BACKGROUND

I.  Univariate Analysis

Univariate analyses are very common in biology (and elsewhere), and you have
undoubtedly conducted them yourself.

A. Descriptive statistics
Usually includes at least the following:
1. Observed limits (range)
2. Sample size (n)
3. Mean (average)
4. Measures of variation around the mean, such as:
Standard deviation (also means dispersal of the individual observations around the
mean, but in the same units as the original observations; standard deviation is the
square root of the sample variance):

B. Inferential statistics

Confidence limits: The range within which a given parameter (such as the true mean) is
predicted to fall at a given confidence level. The conventional confidence levels are
typically 95% or 99%, meaning that the Type | error rate is 5% or 1% respectively. The
Type 1 error rate is the probability of falsely rejecting a true hypothesis. Therefore, if we
specify the 95% confidence limits for the mean of a sample, it means that we estimate
there is only a 5% chance that the true mean of population lies outside of the specified
range.

C. Univariate analysis

The t-test is a common method used in evaluating differences in means between two
groups.

The p-level reported with a t-test represents the probability of error involved in accepting
the hypothesis that there is a significant difference between two sets of data.

If the p-level is 20.05, there is no significant difference between each group.
If the p-level is <0.05, there is a significant difference between each group.

Il. Bivariate analysis

Often, two species are not differentiated on the basis of a single measurement (which is
often a measure of size), but rather on the basis of the relationship between two or more
measurements (which together constitute a measure of shape). For instance,
individuals of most species tend to grow considerably throughout their lives, so any
single measurement is more likely to reflect overall size (and hence age) than anything
else.

For example, suppose we say that fish species A is laterally compressed relative to fish
species B (a statement about shape). If we measure the width of a large number of
specimens of various ages of both species, we are likely to find that the ranges for width
of the two species broadly overlap. Even though width is less for species A than for
species B at a given size, small specimens of species B are probably not as wide as
large specimens of species A. Thus, we need a way to standardize for size. This is
often accomplished simply by a bivariate plot of two variables, such as width and length.
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Notice that although the two species overlap broadly in both length and width, they are
nonetheless easily distinguished by the relationship between these two variables. This
difference may be expressed as a ratio of the two variables, such as width divided by
length.

Bivariate plots are often the most effective way to describe a difference in shape. They
are also useful to describe the relationship between a discontinuous variable (especially
counts that vary with size) and a continuous variable, such as length or weight.

Misconceptions
Probing Questions

Focus Activity/Warm up
Show “Austin Underground” video segment about salamanders.

Engage

The salamander image file contains 3 populations of salamanders (A, B, & C). Students
will use the ImagedJ program to measure salamanders and record total length, body
width, head width and eye width. Use student sheet Morphometric Analysis.

Explore
Under construction



Explain
Under construction

Extend/Elaborate
Under construction

Evaluate
Under construction

Closure/Daily Assessment
Under construction

Differentiation

ELL
Special Education



ImagedJ Software Download

ImagedJ is a free public source image processing and analysis program provided by the National
Institute of Health. While the program has extensive application in the sciences, this
introduction will cover only a few tools relevant to the lesson “Morphometrics of Eurycea in
Austin, TX”. Download from http://rsbweb.nih.gov/ij/download.html

Installation for Windows
Under Windows select bundled with 32-bit Java. (For Mac users, select Imaged 1.43)
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To install ImageJ 1.43 on a computer with Java pre-installed, or to upgrade to the latest WI n d OWS
distribution (including macros, phigins and LUTs), download ij143 zip (3MB) and extras
Image] directory. Use the Help> Update Image] command to upgrade to the latest pre-
release version.

Mac OS X
Dowsnload Image] 1.43 (5.4MB) as a double-clickable Mac OS X application. In;
Imagel64, which uses Java 1.6 in 64-bit mode on Intel Macs running OS X 10, or later.
(Instructions)

Linux
Download Image] 1.43 bundled with 32-bit Java (42MB) or with 64-bit Java (35MB). Both
versions inchide Java 1.6.0_10 from Sun and the Image] spffrce code. (Instructions)

Windows
Download Image] 1.43 bundled with 32-bit Java 1.6.0_10 (25MB). with 64-bit Java
1.6.0_12 (21MB; requires 64-bit Windows) or without Java (3MB). On Vista and
Windows 7. Image] nmst be installed in a directory that the user can write to (e.g..
"Documents"). (Instructions)

Documentation
Tiago Ferreira's comprehensive The Image] User Guide New is available as an 8MB PDF
document. The JavaDoc API documentation (567K) is also available.

Source Code
The Image] Java source consists of 92,000 lines of code in 265 files. It is available online and
as a zip archives.

Example Images
31 downloadable sample images and stacks are available in ImageJ's File=Open Samples
submenu. These images, and more, are also available as a 8 2MB zip archive.

You can also browse the Image] download directory at rsb.info.nih gov/ij/download’. Refer to the release
notes for a list of new features and bug fixes.
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When prompted, click “Run”.

The ImagedJ Setup Wizard should appear shortly.
When prompted, click “Next”.
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The next couple screens will have you select a location to install ImageJ and naming of the
installed location. Click “Next” for the next 3 screens.

The next screen will ask about additional tasks. Ask your instructor if you should select the box

for “create a desktop icon”. (The icon will appear as a microscope on the desktop.) When
ready, click “Next”.
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The following screen will prompt you to install the program. Click “Install”.

You should now see the Completing ImageJ Setup Wizard screen. Click “Finish” which should
automatically launch ImageJ.

The pop-up screen should say Welcome to Imaged. Click “OK”. An ImagedJ configuration pop-
up should appear. Click “OK” and Imaged should now appear as a toolbar at the top of your
screen (similar to the one shown below). To start working with an image in ImageJ, drag and

drop the image file (ie. jpeg) into the gray bar beneath the tool buttons. It will open in a separate
window.



ImageJ Introduction to Basic Functions

Line Selection Tools

Use these tools to create line selections. The three line selection tools share the same toolbar
slot. To switch to a different tool, right click on the current line tool and select the desired tool
from the drop-down menu.

Straight Line Selection Tool

Select the straight line tool. Create a straight line by clicking on the starting point and holding
down the left mouse button, dragging the mouse until you reach the end point. Release the
mouse button and a straight line will remain.

Segmented Line Selection Tool

Select the segmented line tool. Create a segmented line selection by repeatedly clicking with
the mouse. Each click will define a new line segment. Double-click when finished. The points
that define a segmented line selection can be moved or deleted, and new points can be added:
Clicking on an existing point with the Shift key down adds a point.

Clicking on an existing point with the Alt key down deletes it.

Set Scale

Use this dialog to define the spatial scale of the active image so measurement results can be
presented in calibrated units, such as millimeters (mm). Before using this command, use the
straight line selection tool to make a line selection that corresponds to a known distance. Then,
bring up the dialog, enter the Known Distance and unit of measurement, then click ‘OK’.

Imaged will have automatically filled in the Distance in Pixels field based on the length of the line
selection. Leave the Pixel Aspect Ratio setting to a value of 1.0 for this lesson. When Global is
checked, the scale defined in this dialog is used for all opened images during the current
session instead of just the active image. Since the scale is different in each image, Global
should not be checked.

- - Set Scale

Distance in Pixels: 1
Known Distance: (.33348
Pixel Aspect Ratio: 1.0
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Measure

Based on the selection type, calculates and displays either area statistics, line lengths and
angles, or point coordinates. Calculates line length and angle if a line selection has been
created using one of the three line selection tools. Records coordinates if one or more points
have been defined using the point selection tool. Use the Analyze>Set Measurements
command to specify what area statistics are recorded. For this lesson, be sure all boxes are
unchecked. Once a line is created, use the Analyze>Measure command to measure the line
length. Results table (similar to below) will pop up once a measurement is taken, but only line
length should be reported.

¢ Results =& %
File Edit
|Area |Mean |Ethev |ru1in |Max |Cir|:. | -

1 48588  G7.454  BET7B48 8 243 04588
2 34304 107140 69713 16 248 0674
3 131194 103528 70423 8 243 04938
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Morphometric Analysis of Eurycea in Austin, TX
Student Sheet

You and your fellow classmates have visited two spring sites in Austin, Texas: Parthenia Spring
(within Barton Springs Pool in Zilker Park) and Wheless Spring (within Wheless preserve in NW
Austin near Lake Travis). Both of these sites are home to aquatic salamanders, but you would
like to determine if they are the same species. At Parthenia Spring, you observe that some
salamanders are distinctly different based on their eyes (both size and appearance). This leads
you to wonder whether this is natural variation of a single species or if there are two distinct
species at this site; therefore, you have classified these two eye variations into two groups for
your analyses.

The two most common ways of differentiating between species are using morphometrics and
genetics. Without having a genetics lab, you decide to employ morphometrics to determine if
the spring sites are host to the same species or different species.

Methods
A subset of each population is captured, photographed, and released back to the site of capture.
The populations and associated photographs have been split into three categories:

Population A — salamanders with larger eyes at Parthenia Spring

Population B — salamanders with smaller eyes at Parthenia Spring

Population C — salamanders at Wheless Spring

Photographs were taken using a scale for measuring back in the classroom. There are three
different scales used in the photographs; ruler in centimeters, ruler in inches, and a grid of 4
squares = 1 inch. Be sure to use the correct scale for each image and convert all measurements
to millimeters for analyses. Using the program ImageJ, you measure (as accurately as possible)
a few quantitative variables of each individual that will be used for comparison:

o Total length (tip of snout to tip of tail,
following the center line of the body)
e Body width (width at the widest part of
the torso — use your best judgement)
e Head width (width at the widest part of
the head — use your best judgement)
e Eye width (distance between two eye
spots, center of spot to center of spot)
* Refer to the ImageJ worksheet to
provide you with instructions on
installation of the program (if
applicable)and how to use ImagelJ.

I Total Length




ImageJ Student Sheet

1. Open afile. On the toolbar, click on File, Open and navigate to a salamander image file
(jpeg) from population A, B, or C. The salamander image will open in a separate
window.
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2. Set the Scale. The new window shows a salamander and a ruler. Before measuring the
salamander you will need to set the scale. There are three different scales used in the
photographs; ruler in centimeters, ruler in inches, and a grid of 4 squares = linch.

To set your scale:

e Click on the straight line tool . Click on a major line segment on the ruler and
holding down the left mouse button drag the mouse until you reach another major
line on the ruler. Release the mouse button and a straight line will remain (see
example below).
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e On the toolbar, click on Analyze-Set Scale...change known distance to the
distance you measured (ie. 3.0) and change unit of length to cm (or inches
depending on the ruler units). Click OK.
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3. Measure the salamander.

e On the toolbar, right click on the line selection tool to open the drop down menu and

click on Segmented Iine.

e To measure the total length of the salamander, move the curser to the tip of the
salamander tail and double click. Drag and click the line along the middle of the
salamander body (more clicks=more accuracy) until you reach the snout of the

salamander. Double click to end line.

e On the toolbar, click on Analyze, Measure (see example below). Look for length and
record total length (in mm*) of salamander on your data sheet. *convert cm to mm by
multiplying 10. In this example the total length = 51.5 mm.

e Next measure body width (width at the widest part of the torso-use your best judgement)

and record body width (in mm) on your data sheet.

_ ImagelJ
File Edit Image Process Analyze Plugins Window Help
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Once the data has been entered into an Excel spreadsheet, it is time to start the analyses.

Below is a list of the analyses you should complete for each population and each
measured variable (total length, body width, head width, and eye width). The excel
formulas for each are given below and can also be observed in use in the “Sample
Datasheet” worksheet:

Mean =AVERAGE(numberl,number2,...)

Standard deviation =STDEV(numberl, number2,...)

T-test =TTEST (arrayl,array2,tails,type)
Array 1 is the measured values of one variable for population 1
Array 2 is the measured values of the same variable for population 2
Tails should be 2, referring to the probability distribution of the data
Type should be 1, referring to the kind of t-test (1 represents “paired”)

* The value reported in the cell will be the p-value with 95% confidence

limits

Using univariate analysis (t-tests), are there significant differences between the following

and how do you know:

Population A and B
Total Length
Body Width
Head Width
Eye Width

Population A and C
Total Length
Body Width
Head Width
Eye Width

Population B and C
Total Length

Body Width
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Head Width

Eye Width

Now it is time to take a bivariate approach. You are going to make three scatter plots
with data from all three populations. Each population, A, B, and C, should be its own
series in each plot. Describe any trends you observe in each of the following three plots
and discuss how plotting the data either supports or refutes the univariate analyses above:

Total Length vs Body Width

Head Width vs Eye Width

Total Length vs Head Width

Lastly, you will calculate the ratios for each point on you bivariate plots. This is done by
dividing the value on X axis by the value on the Y axis. Create new columns in your
Excel spreadsheet to display the ratios. Repeat the univariate analyses (mean, standard
deviation, and t-test) for the ratios.

Using univariate analysis (t-tests) of variable ratios, are there significant differences
between the following and how do you know:

Population A and B

Total Length/Body Width

Head Width/Eye Width

Total Length/Head Width
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Population A and C

Total Length/Body Width

Head Width/Eye Width

Total Length/Head Width

Population B and C

Total Length/Body Width

Head Width/Eye Width

Total Length/Head Width

Based on the information obtained from the univariate analyses and the bivariate plots,

would you conclude that Populations A, B, and C are the same or different species using
morphometrics alone? Report supporting and refuting evidence within your conclusions.
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